
PIF Editor Help Index--Standard Mode
The Index lists the Help topics available for PIF Editor's Standard Mode. Use the scroll bar to see more 
index entries.
To learn how to use Help, press F1 or choose Using Help from the Help menu.
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PIF Editor Help Index--386 Enhanced Mode
The Index lists the Help topics available for PIF Editor 386 enhanced mode. Use the scroll bar to see 
more index entries.
To learn how to use Help, press F1 or choose Using Help from the Help menu.
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PIF Editor Help Index--Advanced Options for 386 Enhanced Mode
The Index lists the Help topics available for PIF Editor's Advanced options for 386 enhanced mode. Use 
the scroll bar to see more index entries.
To learn how to use Help, press F1 or choose Using Help from the Help menu.

Keyboard
PIF Editor Keys

Commands
File Menu Commands
Mode Menu Commands

Procedures
Creating New PIFs
Editing PIFs
Modifying the Standard PIF Settings

Windows 386 Enhanced Mode Options
Close Window on Exit
Display Usage
Execution Background
Execution Exclusive
Memory Requirements
Optional Parameters
Program Filename
Start-up Directory
Window Title

Advanced Options for 386 Enhanced Mode
Allow Close When Active
Allow Fast Paste
Application Shortcut Key
Background and Foreground Priority
Detect Idle Time
EMS Memory
Emulate Text Mode
Lock Application Memory
Monitor Ports
Reserve Shortcut Keys
Retain Video Memory
Uses High Memory Area
Video Memory
XMS Memory





PIF Editor Keys
Use the following keys in PIF Editor:

Key(s) Function
Tab Moves from option to option (left to right and top to bottom).
Shift+Tab Moves from option to option in reverse order.
Alt+letter Moves to the option or group whose underlined letter matches the one you type.
direction keys Move from option to option within a group of options.
Spacebar Selects or clears a check box.
Alt+Esc Switches to the next application window or minimized icon, including full-screen 

applications.





PIF Editor Commands
To get help with a command, choose the appropriate menu.

File Menu Commands
New
Open
Save
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File Menu Commands
Use the scroll bar to see more commands.

New
Opens a new file with the standard settings.
When you choose New, PIF Editor lets you save changes to the current file.

Related Topics
Creating New PIFs

Open
Opens an existing settings file.
When you choose Open, PIF Editor lets you save changes to the current file.

Related Topics
Creating New PIFs
Editing PIFs

Save
Saves changes to the current file.
When you choose Save, the file remains open so you can continue working on it.

Related Topics
Editing PIFs

Save As
Saves a new or existing settings file.
You can
* Name a new PIF with a .PIF extension.

Although PIF Editor will allow you to save a PIF with another extension, Windows will only use files that 
have .PIF as the extension.

* Save an existing file under a new name.
The original remains unchanged.

Related Topics
Creating New PIFs
Editing PIFs

Exit
Closes the current file and exits PIF Editor.
If a file is unsaved, PIF Editor lets you save it before exiting.



Mode Menu Commands
Standard
Switches PIF Editor settings to standard mode.

386 Enhanced
Switches PIF Editor settings to 386 Enhanced mode.

Related Topics
Creating New PIFs





PIF Editor Procedures
The Procedure topics give you step-by-step instructions for using PIF Editor.
To learn how to use Help, press F1 or choose Using Help from the Help menu.

Working with PIF Editor
Creating New PIFs
Modifying the Standard PIF Settings
Editing PIFs



Creating New PIFs
You can run PIF Editor for either standard or 386 enhanced mode. You can also create a PIF that works 
for a non-Windows application that will run in standard and 386 enhanced modes.

To create a new PIF from scratch:
1 Choose Standard or 386 Enhanced from the Mode menu.
2 Choose New from the File menu.
3 Specify the options that apply to the application.
4 Choose Standard or 386 Enhanced to switch to the other mode if you plan to run the application in 

both modes.
5 Specify the appropriate options for that mode.
6 Choose Save As from the File menu.
7 Type the filename with .PIF as the extension.
8 Choose OK.

To create a new PIF automatically:
1 Start Windows Setup.
2 Set up the application for use with Windows.

Use Windows Setup Help for instructions on how to set up an application.

Related Topics
Advanced Options for 386 Enhanced Mode
Modifying the Standard PIF Settings
Windows 386 Enhanced Mode Options
Windows Standard Mode Options



Modifying the Standard PIF Settings
When you start a non-Windows application and Windows can't find a PIF for the application, it starts the 
application using the standard settings. You can override these settings by creating a PIF with the 
filename _DEFAULT.PIF.

To override the standard PIF settings:
1 Change the settings in PIF Editor as appropriate.

Leave the Windows Title option blank.
Windows ignores certain settings, such as Program Filename, when it uses the settings in _DEFAULT.PIF to start
an application. However, because PIF Editor still verifies the contents of these fields, you should still provide 
complete valid settings.

2 Choose Save As from the File menu.
3 Specify the filename _DEFAULT.PIF.
4 Choose OK.

From now on, whenever Windows can't find an application's PIF, it will start the application using the settings in 
the _DEFAULT.PIF file rather than using Windows' standard PIF settings.



Editing PIFs
When an application doesn't run properly, you can try editing its PIF.

To edit a PIF:
1 Choose Open from the File menu.
2 Enter the filename.
3 Choose OK.
4 Specify the options that you want to change.

For example, you might want to:
* Change the pathname for your application.
* Specify a program parameter or change the default directory that contains your application's files.
* Give it more or all available memory.
* Run it in a window (this requires more memory than running it full screen).

5 Choose Save from the File menu.

Related Topics
Advanced Options for 386 Enhanced Mode
Windows 386 Enhanced Mode Options
Windows Standard Mode Options





Windows Standard Mode Options
These topics give you step-by-step instructions for using PIF Editor's Standard Mode options. Use the 
scroll bar to see more topics.
To learn how to use Help, press F1 or choose Using Help from the Help menu.
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Close Window on Exit
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Program Filename
In this text box, you specify a path for the application, including the drive, directory, and the extension for
the command file--for example, C:\MULTIPLAN\MP.COM. You must make an entry in this box. Be sure 
to include the complete path for the program filename and also include the extension.
If you want to use the PIF when you run the application, make sure the program name in Program 
Manager matches the program filename you want to use. For example, if the filename is MP.COM 
(Multiplan), you would use the name MP.PIF.
If you run the application by choosing the PIF itself from File Manager, the two names need not match. 
For example, you might want to create more than one PIF for an application, each with a different name 
and different settings. However, when the names do not match, the PIF is only used when you run the 
application by choosing the PIF itself.
You may want to run other commands before your application--for example, Set commands or those that
load memory-resident applications. You can put these commands in a batch file. The following is an 
example of how you would set up a batch file for an application such as Multiplan:
* Create MP.BAT (with a text editor such as Notepad) and make the last command MP.PIF.

Related Topics
Optional Parameters
Start-up Directory
Window Title



Window Title
In this text box, you can specify a descriptive name that will appear in the window's title bar when you 
run the application. This entry is optional.
If you leave this text box blank, the title bar will display the name of the PIF without the extension .PIF.

Related Topics
Program Filename



Optional Parameters
In this text box, you specify any parameters your application might need. These are the same 
parameters you would type after the application's filename when starting the program outside Windows. 
For example, to run Microsoft Word in character mode, type /c in this box. If your application doesn't 
require parameters or if you are uncertain about what parameters to specify, leave this text box blank.
Parameters can be filenames, letters, numbers, or any type of information up to 62 characters in length. 
See the application documentation for valid parameters. If your application doesn't require parameters or
you don't want to use them, leave this box blank.
If you want Windows to prompt you for parameters, type a question mark. When starting the application, 
you will be prompted to supply the parameters you want.
If you choose the Run command in Program Manager or File Manager, you can override the program 
parameters specified in the PIF by typing parameters after the program name.

Related Topics
Program Filename



Start-up Directory
In this text box, you specify the drive and directory you want Windows to go to when you start the 
application. This is usually the location of the application or the application's files. This entry is optional. 
If you want Windows to determine the start-up directory, leave this option blank.
Some applications require that certain files be located in the same path as the application. In this case, 
you should specify a start-up directory location that is the same as that of the files.

Related Topics
Program Filename



Video Mode
With the Video Mode option, you can specify whether Windows should reserve enough memory to run 
your application in text mode or in graphics/multiple text mode. ("Multiple text" refers to applications that 
use multiple text pages to display multiple text screens that can be selected.) The Video Mode option 
tells Windows how much memory it will need for saving and restoring the video state, and for copying 
the screen contents onto the Clipboard.
The amount of memory allocated for these functions should be as small as possible, so that more 
memory is available for other uses. Since text mode uses less memory, you may want to try choosing 
Text first if you are uncertain about which option to choose.
For an application that runs in both text and graphics mode, select Graphics/Multiple Text.



Memory Requirements
In this text box, you can specify an amount of memory in kilobytes (KB) that will be required for the 
application. Check the system requirements for your application. If you don't know how much is required,
leave the setting as it is.
If you are running other applications and Windows cannot provide the specified amount of memory when
you start the application, you will see the message "Not enough memory to run." You may need to close 
some applications before continuing.
Note that the value for this option specifies the amount of memory available for the application, not the 
total size including DOS, device drivers, and so on.



XMS Memory
In the XMS Memory text boxes, you can specify the amount of extended memory you want set aside for 
your application. If you have extended memory in your computer that conforms to the Lotus-Intel-
Microsoft (LIM) eXtended Memory Specification, version 2.0 or greater, you can use these settings.

This option Sets
KB Required A minimum amount of required extended memory in kilobytes (KB). Check the system 

requirements for your application. If you don't know how much is required, leave the 
setting as it is.
If you are running other applications and Windows cannot provide the specified 
amount of memory when you start the application, you will see the message "Not 
enough memory to run." You may need to close some applications before continuing.
Use a setting of 0 for applications which do not use extended memory.

KB Limit The maximum amount of extended memory in kilobytes (KB) that will be allocated to 
the application.
This setting prevents XMS-using applications from tying up all available extended 
memory blocks when they will not use them all. It is also used for limiting an 
application's use of extended memory so that the application will run better with other 
applications that use extended memory.
The default setting is 0. A setting of -1 allocates as much extended memory to an 
application as it asks for up to the limit of system memory. A setting of 0 will prevent 
the application from gaining access to any extended memory, except in the high 
memory area (HMA).

Related Topics
Memory Requirements



Directly Modifies (Communications Ports)
Some applications use system resources in ways that prevent sharing with other applications. For each 
serial communications port (COM1, COM2, COM3, COM4) that your application accesses, select the 
check box. If you are running a communications program, you should check these boxes.
Selecting this option prevents two applications from trying to access the same communications port at 
once. It also prevents the application from swapping to disk.

Related Topics
Directly Modifies (Keyboard)



Directly Modifies (Keyboard)
Some applications use system resources in ways that prevent sharing with other applications. Select the
Keyboard check box if the application accesses the keyboard buffer, which is the area in memory that 
remembers keys that were typed, even if the computer was busy and not responding to the keyboard 
when you typed them. If you are uncertain about whether the application accesses the keyboard buffer, 
do not select this option.
Selecting this option allows your program exclusive access to the keyboard and prevents switching back
to Windows with Alt+Tab, Alt+Esc, and Ctrl+Esc.

Related Topics
Directly Modifies (Communications Ports)



No Screen Exchange
Selecting this check box prevents you from using Alt+PrtSc and PrtSc to put "snapshots" of the screen 
onto Clipboard. If you are uncertain about whether you should select this option, do not select this check
box.
Selecting this option keeps Windows from allocating memory for the screen exchange function and thus 
frees memory for running the application.



Prevent Program Switch
Selecting this check box prevents you from using Alt+Tab, Alt+Esc, or Ctrl+Esc to switch back to 
Windows from the application. If you are uncertain about whether you should select this option, do not 
select this check box.
Selecting this option keeps Windows from allocating memory for program switching and thus frees 
memory for running the application.
Select this option if you find that the application does not switch to Windows correctly. Also select this 
option when the application is a BASIC program that uses the communications port.
If you select this option, you must quit the application in order to return to Windows.



Close Window on Exit
When you quit a non-Windows application, the window (or screen) closes automatically. If you want the 
window to remain open so that you can look at the information on the screen, select this check box.



Reserve Shortcut Keys
Selecting the check boxes for the shortcut keys (Alt+Tab, Alt+Esc, Ctrl+Esc, Alt+PrtSc, PrtSc) reserves 
them for use by the application instead of by Windows.
If your application uses these shortcut keys, select the check box. This selection disables the Windows 
functions for the keys and allows the application to use them while the application is the current 
application. (When the application is not the current application, the shortcut keys have Windows 
functions.)





Windows 386 Enhanced Mode Options
These topics give you step-by-step instructions for using PIF Editor's 386 enhanced mode options. Use 
the scroll bar to see more topics.
To learn how to use Help, press F1 or choose Using Help from the Help menu.

Windows 386 Enhanced Mode Options
Close Window on Exit
Display Usage
Execution Background
Execution Exclusive
Memory Requirements
Optional Parameters
Program Filename
Start-up Directory
Window Title



Memory Requirements
These settings allocate memory to the application. If you leave the settings blank, Windows will allocate 
640K of memory to the application if the memory is available.
Note that the values for these settings specify the amount of memory available for the application, not 
the total size including DOS, device drivers, and so on.

This setting Specifies
KB Required The minimum amount of memory in kilobytes (KB) that your application requires. 

Check the system requirements of your application. If you don't know how much is 
required, leave the setting as it is.
If you are running other applications and Windows cannot provide the specified 
amount of memory when you start the application, you will see the message "Not 
enough memory to run." You may need to close some applications or use a larger 
number before continuing.
Entering 0 indicates that the application has no minimum memory requirement; 
therefore, Windows will allocate to the application whatever memory is available. Enter
-1 to allocate as much memory as possible to the application.

KB Desired The maximum amount of memory that your application can use. Some applications 
run better if more than minimal memory is provided. The limit is 640K.
Enter -1 to allocate as much memory as possible to the application.



Display Usage
The Full Screen and Windowed options control how the application screen is initially displayed.

This option Starts
Full Screen The application full-screen (without a window).

Running an application full-screen saves memory. You'll be able to switch between a 
full-screen application and Windows by pressing Alt+Tab. However, you cannot share 
information between full-screen applications and other applications as easily as if they 
were running in a window. (You can press Alt+PrtSc to load an entire screen onto 
Clipboard when an application is running full-screen.)
To put an application in a window while using it, press Alt+Enter. Some applications 
can only run full-screen because they display graphics, or they have direct access to 
the part of memory used by the screen. In these cases, you'll get a message that you 
can't switch to a window.

Windowed The application in a window.



Execution Background
If you want the application to be able to run when it is not the current application, select the Background 
check box.
If you select the option, the application will run in the background (calculating numbers, for example) 
while another application has focus in the foreground. If you don't select this option, the application will 
run only when it is switched to the foreground.

Related Topics
Execution Exclusive



Execution Exclusive
If you want the application to have exclusive use of resources when it is the current application, select 
this check box. If you select the option, no other applications, including those with the Background 
option set, will run when this application is in the foreground.
This option controls the behavior of the application only when it is the current application. Use the 
Background option to control its behavior when it is in the background.
You can select this option for applications running both in a window and running full-screen. However, an
application running in a window will not actually receive all the computer's memory resources. Some 
memory will be reserved for Windows to manage the screen display.

Related Topics
Execution Background





Advanced Options for 386 Enhanced Mode
These topics give you step-by-step instructions for using PIF Editor's Advanced options for 386 
enhanced mode. Use the scroll bar to see more topics.
To learn how to use Help, press F1 or choose Using Help from the Help menu.

Multitasking Options
Background and Foreground Priority
Detect Idle Time

Memory Options
EMS Memory
Lock Application Memory
Uses High Memory Area
XMS Memory

Display Options
Emulate Text Mode
Monitor Ports
Retain Video Memory
Video Memory

Other Options
Allow Close When Active
Allow Fast Paste
Application Shortcut Key
Reserve Shortcut Keys



Background and Foreground Priority
When you specify priority, you are determining the allocation of CPU resources to the applications. The 
numbers you specify in the Background and Foreground text boxes set the priority of the application 
relative to the other applications that are running. (Therefore, these numbers cannot be translated into a 
fixed percentage of CPU time.) The larger the priority you give an application, the more CPU resources 
are allocated to it.
Priorities range from 1 to 10,000. Normal priority is 100 (with the possibility of other applications having 
100 times greater and 100 times less priority).
The Foreground Priority is the application's priority when it is the current application.
The Background Priority is the application's priority when it is not the current application. (This setting is 
ignored if the Execution Background option is not set.)



Detect Idle Time
If you select this check box, Windows will give CPU resources to another application when this 
application is waiting for keyboard input.
Generally, you should check this option because it allows other applications to run faster.
Some applications will not run correctly with this option selected. The only way to determine if the 
application will work is to select this option and see if it runs more slowly. If not, leaving this box checked
will allow other applications in the background to run faster.



EMS Memory
EMS Memory options let you specify the amount of expanded memory to allocate to an application. If 
your application makes use of expanded memory, you should set EMS options rather than XMS options.
Note: When running in virtual mode, Windows allocates EMS and XMS memory from the same memory 
pool, using the application's memory strategy: either the Lotus-Intel-Microsoft (LIM) Expanded Memory 
Specification or Lotus-Intel-Microsoft (LIM) eXtended Memory Specification.

This option Specifies
KB Required The minimum amount of expanded memory in kilobytes (KB) that your application 

requires. See the application's documentation for this information. If you don't know 
how much EMS memory is required, leave the setting as it is.
If Windows cannot provide the specified amount of memory, and you are running 
other applications, you will see the message "Not enough memory to run." You may 
need to close some applications before continuing.
A setting of 0 is appropriate for applications that do not use LIM 4.0 expanded 
memory.

KB Limit The maximum amount of LIM 4.0 expanded memory your application is allowed to 
use. This option is provided to prevent an application from taking more expanded 
memory than it needs. Setting this option also limits an application's use of expanded
memory so that it will run better with other applications that use LIM 4.0 memory.
The default setting is 1024. A setting of -1 allocates as much expanded memory to an
application as it asks for, up to the limit of system memory. A setting of 0 will prevent 
the application from gaining access to any EMS memory.

Locked That the memory allocated to the application is locked into actual physical RAM. Most
applications will run well with expanded memory unlocked. The advantage of having 
the memory unlocked is that it allows your application to use virtual memory. This 
means that if the application needs more memory than is physically in your computer,
it will swap the least used information to disk, giving the appearance of more memory
than is actually present.
Two cases where the application will not run well with the expanded memory 
unlocked are when you have a memory-resident application that uses expanded 
memory at interrupt time, or when you have a DOS device driver that uses expanded
memory. In these cases, the application may need to be in physical RAM to work.

Related Topics
Memory Requirements
XMS Memory



XMS Memory
XMS memory options specify the extended memory available to your application. If you have installed 
extended memory that conforms to the Lotus-Intel-Microsoft (LIM) eXtended Memory Specification, 
version 2.0 or greater, you can specify XMS settings.

This setting Specifies
KB Required The minimum amount of required extended memory in kilobytes (KB) your 

application needs to run. Check the system requirements for your application. If you
don't know how much is required, leave the setting as it is.
If you are running other applications and Windows cannot provide the specified 
amount of memory when you start the application, you will see the message "Not 
enough memory to run." You may need to close some applications before 
continuing.
Use a setting of 0 for applications which do not use extended memory.

KB Limit The maximum amount of extended memory in kilobytes (KB) that will be allocated 
to the application.
This setting prevents XMS-using applications from tying up all available extended 
memory blocks when they are not going to use them all. This allows the application 
to run better with other applications that use extended memory.
The default setting is 1024. A setting of -1 allocates as much extended memory to 
an application as it asks for, up to the limit of system memory. A setting of 0 will 
prevent the application from gaining access to any extended memory, except the 
high memory area (HMA).

Locked That the memory allocated to the application is locked into actual physical RAM. 
Most applications will run well with extended memory unlocked. The advantage of 
having the memory unlocked is that it allows your application to use virtual memory. 
This means that if the application needs more memory than is physically in your 
computer, it will swap the least used information to disk, giving the appearance of 
having more memory than is actually present.
Two cases when the application will not run well with the extended memory 
unlocked are when you have a memory-resident application that uses memory at 
interrupt time, or when you have a DOS device driver that uses memory. In these 
cases, the application may need to reside in physical RAM to work.
The High Memory Area (HMA) is always locked and therefore this setting has no 
effect on it.

Related Topics
EMS Memory
Memory Requirements



Uses High Memory Area
When you select this check box, you specify that an application will have access to the high memory 
area (HMA). If you have installed extended memory that conforms to the Lotus-Intel-Microsoft (LIM) 
eXtended Memory Specification, version 2.0 or greater, you can use this setting.
The HMA is a system resource that only one application at a time can use. In most cases, you can 
choose this option because each application has its own HMA, which is independent of all the other 
applications' HMAs. However, you should turn off this check box when you don't want a particular 
application to vie for a specific HMA.

Related Topics
EMS Memory
XMS Memory



Lock Application Memory
Selecting this check box overrides the application's normal switching from real memory to disk, and 
forces all of the application's DOS memory to be in real memory when the application is running. 
Generally, you should not select this option, since it limits the number of applications you will be able to 
run with Windows. The option is provided to help applications whose performance or correct functioning 
is severely affected by the extra time that is required to read and write memory from disk.
Note also that this option applies only to the main application memory and does not apply to XMS or 
EMS memory.

Related Topics
EMS Memory
XMS Memory



Video Memory
With this option, you specify the video mode you want the application to start in. Windows will allocate 
system memory to display the application screen in accordance with the video mode you specify. Text 
mode uses the least amount of memory and High (resolution) Graphics mode uses the most.
If the application does not have enough memory for saving the video memory, you will not be able to 
start the application after specifying the mode. Instead, Windows will give you a message that it has 
insufficient memory to run the application.
Some applications can run in several modes. If you change to a mode that requires less memory or if 
you run an application full-screen, Windows releases the extra memory for use by other applications. If 
you change back to a mode that requires more memory for video display, it may not be available, and 
the application display may be partially or totally lost.
If you want to prevent this from occurring when you change modes, you can select both the High 
Graphics option button and the Retain Video Memory check box. That way, you will always have the 
memory needed to display the application, regardless of the mode the application is running in. 
However, you will have less available memory for other applications, which means you may not have 
enough memory to run them.
Some adaptors, such as the Hercules and CGA, have only one graphics mode, so there is no difference 
between the Low Graphics and High Graphics options.

Related Topics
Monitor Ports
Retain Video Memory



Monitor Ports
This option tells Windows to verify that the values assigned to the video adaptor are the same as those 
used by the application when it is running in a specified mode (Text, Low Graphics, or High Graphics). 
For example, both the video adaptor and the application can determine what the cursor looks like. As 
long as the values are the same, these options are not needed. However, the application may not 
display correctly if its values and the video adaptor's values differ.
If you do not choose any of the Monitor Ports options and the application's screen is not restored 
correctly when the application is made full-screen, choose the option that corresponds to the mode the 
application is running in. If the screen is still not restored correctly, choose the other Monitor Ports 
options one by one.
When none of these options is selected, the application will access the full-screen display more quickly. 
However, you run the risk of being unable to restore your application's display properly. These options 
have no effect when the application is running in a window.
Choosing these options will not affect some display adapters, such as the IBM VGA adapter.

This option Tells
Text Windows to monitor the ports associated with text mode displays.
Low Graphics Windows to monitor the ports associated with low resolution graphics mode displays.

CGA mode screens are low graphics.
High Graphics Windows to monitor the ports associated with high resolution graphics mode displays.

EGA mode screens are high graphics.

Related Topics
Video Memory



Emulate Text Mode
Many applications run with the display in text mode and use the standard ROM BIOS services for their 
output. If you select this option, the display update of these applications will run faster.
If the application's display gets garbled or the cursor appears in the wrong place, turn off this check box.



Retain Video Memory
If you select this check box, Windows will set the amount of memory needed for the start-up video mode
and will not give back any memory to the system, even if you switch video modes while running the 
application.
A single application may run in several different video modes. If this option is not checked, Windows will 
adjust the system memory allocated to the application according to the video mode the application is 
running in. If the memory needed is smaller in the new mode, video memory will be returned to the 
system so that it can be used by other applications. This means that if the application switches back into 
a video mode that requires more memory, the memory may not be available, and you may lose the 
application's screen.

Related Topics
Video Memory



Allow Fast Paste
If you select this check box, the application will paste information using a faster method. Because some 
applications cannot paste properly using this method, you will need to test it by trying to paste 
information from Clipboard to the application. If the paste is successful, you can use the option.



Allow Close When Active
If you select this check box, Windows will be able to close an application when you exit Windows. This 
feature allows you to exit Windows without having to quit the active application first. If you select this 
option, you will see a confirmation message about quitting the application when you exit Windows.
If you are uncertain about whether to select this option, do not select the check box. Choosing this 
option could result in data loss and damage to DOS files, because many standard applications will not 
be allowed to close their open files and copy the contents of their buffers to disk. This could result in a 
wholesale loss of data.
This option should only be set for applications that do not write to the disk. PIFs for applications that use 
the disk regularly, such as word processors, data bases, and spreadsheets, should never check this 
option.



Reserve Shortcut Keys
Selecting the check boxes for the shortcut keys (Alt+Tab, Alt+Esc, Ctrl+Esc, Alt+PrtSc, Alt+Spacebar, 
Alt+Enter, PrtSc) disables the Windows functions for the keys and allows the application to use them 
while the application is the current application. (When the application is not the current application, the 
shortcut keys have Windows functions.)
If your application uses a Windows shortcut key, select the check box. This selection lets you use the 
shortcut key in the application but prevents you from using it in Windows.



Application Shortcut Key
In this text box, you can enter a key combination (or shortcut key) that causes the application to become
the current application when it is pressed. Shortcut keys must have an Alt or Ctrl modifier. Shift can also 
be specified, but it is not allowed by itself.
To enter the shortcut key, press the key combination you want to use. If there is something wrong with 
the shortcut key definition, a dialog box will appear and the shortcut key will be reset. (You can't use as 
shortcut keys the keys and key combinations reserved for working within the option and dialog box.) 
When you are finished, press Enter to accept the settings in the dialog box or press Tab to move to 
another option. Use Backspace to delete a shortcut key definition and Shift+Backspace to set the 
definition to none. (You cannot otherwise edit a definition.)
The shortcut key you specify will work system-wide. This means no other application, including a 
Windows application, is allowed to use the key combination. For this reason, shortcut keys must be 
selected carefully. For instance, you cannot specify a shortcut key that conflicts with the Windows 
shortcut keys. Also, if the shortcut key conflicts with an accelerator key in a Windows application or 
dialog box, the accelerator will be disabled. You should also specify a shortcut key that will not conflict 
with any shortcut keys defined by another non-Windows application.

Related Topics
Reserve Shortcut Keys





active
Describes the selected window or icon that you are working with. Windows always applies the next 
keystroke or command you choose to the active window. If a window is active, it appears in front of all 
other windows on the desktop, and its title bar changes color to differentiate it visually from other 
windows. If an icon is made active, its Control menu appears.
Inactive is the opposite of active and describes windows or icons on the desktop that are not selected.



full-screen application
A non-Windows application that uses the entire screen, rather than a window, to run in the Windows 
environment.



non-Windows application
Applications that were not designed to run in Windows. Non-Windows applications do not necessarily 
conform to Windows user-interface standards.



shortcut key
A special key or key combination, available for some commands, that you can press to execute the 
command without first selecting a menu. The shortcut key for a command is listed to the right of the 
command name on the menu.




